Please Note

This presentation iIs being provided for
Informational purposes only.

The Iinformation In this presentation may have
changed since it was created.

This presentation Is not meant to provide detailed

reporting instructions and is not a replacement for

the EMIS Manual, Report Explanations, or other
documentation provided by ODE.
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The Usual Reminders

» Manual sections posted after this training
prevalil in a conflict between this
presentation and the manual

» Some questions may be deferred to
helpdesk

» Hierarchy of support
> EMIS Manual
>» EMIS Coordinator
>ITC
> Helpdesk



Topics

»Midyear Student (S) Collection and SOES
End of Year Student (S) Collection

> Student Truancy and Excessive Absence
(FT) Record

> Preschool Scenarios

p Staff/Course (L) Collections
» TLC Status Report

» Assessment (A) Collections
»March Follow-up (D) Collection
» ODDEX Updates and Reminders



MIDYEAR

STUDENT (S) COLLECTION
AND SOES END OF YEAR
STUDENT (S) COLLECTION



Midyear & End of Year Student (S)
Collections Elements

» Foreign Exchange Student Graduation Plan
(FD190)

» Homeless Status (FD150)*

» Homeless Unaccompanied Youth (FD160)
» Immigrant Status (FD200)

» Migrant Status (FD180)

» Preschool Poverty Level (FD120)

P Student being served by 504 Plan (FD140)




Student Truancy and Excessive
Absence (FT) Record

» Unexcused absences due to suspension
» Do not count toward truancy trigger

> WIll count toward excessive absence
measure

» Does not apply to preschoolers

Building |EMIS Student |State Student |Absence Record Is
Last Name First N\ame |IRN ID Number ID Event Event Date |Valid
Not Available |[Not Available | 000222 Not Available |AA0001234 A 20171130 |[No
Not Available |[Not Available |000222 Not Available [BB0012345 B 20171130 |Yes
Not Available |Not Available (000222 Not Available [CC0123456 C 20171130 |Yes
Not Available |Not Available [000222 Not Available |DD1234567 D 20171130 [No




CCP Attendance Under HB410

» Onsite for any part of school day

» Full day — district would apply absence to both
district and CCP portions of student’s day

> Partial day — district would apply absence to
relevant portion of student’s day
P Offsite, part time (college campus or online)
» District only responsible for tracking attendance
for time required to be at district

» Offsite, full time (college campus or online)

» District has no responsibility for tracking
attendance



Reading Diagnostic Result (FN370)

» Districts must administer Reading
Diagnostic assessment to

> All students in grades KG-3
» Enrolled 30 or more days
» Students newly enrolled throughout the year
» Students transferring in throughout the year

» Assessed more than once during the school
year
> Only report initial results



Valid Options

p** — Not required
> Only report for students enrolled fewer than
30 days and not given a diagnostic
»EX — Exempt from Diagnostic Assessment
> Only report for students with the most
significant cognitive disabllities
» RN — Required, not assessed

> Report for students enrolled 30 or more days,
not assessed



Reading Improvement and
Monitoring Plan (RIMP)

»Not on track students must have a RIMP
written and implemented within 60 days of
return of diagnostic result

> RIMP specific interventions reported in EMIS
» Student Program Code (GQ) Record

» On track students may be placed on a RIMP
If district determines student is in need of
Intervention

» Same rule applies
» 60 days from vendor results available
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RIMP, cont.

Student Program (GQ) Record

> Only report if on a RIMP and interventions
provided

» Start dates not collected in EMIS

» Districts responsible for maintaining
documentation/data to support reporting
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Preschool Reporting Scenarios

»Scenario 1: Student with a disability (SWD)
at BDD

How Received How Received District Percentage of Sent To
Who Reports?
Element IRN Relationship Time Reason/IRN/% of time

District of Res kKK MR/BDD IRN/0%

P Scenario 2: SWD, open enrolled to District
B, at ESC

Who Reports? How Received How Received District Percentage of Sent To
P Element IRN Relatlonshlp Time Reason/IRN/% of time

District of Res o o ok ok OE/District B IRN/0%

ESC H District B 1 50 NA/****** /09,
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PS Scenarios, cont.

»Scenario 3: Typical, 4 yr old, Early
Childhood Education (ECE) Grant funded,
at ESC

Who Reports? How Received How Received District Percentage of Sent To
i Element IRN Relationship Time Reason/IRN/% of time

********

>Scenar|o 4. SWD, 4 yr oId, ECE Grant
funded, at ESC

Who Reports? How Received How Received District Percentage of Sent To
i SICIRENE IRN Relationship Time Reason/IRN/% of time

District of Res [ ES/ESC IRN/0%

ESC E DOR 1 50 NA/ ¥ xkxk /0%
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PS Scenarios, cont.

» Scenario 5: Typical, enrolled in ESC operated
preschool, direct pay

Who Reports? How Received How Received District Percentage of Sent To
i AR IRN Relationship Time Reason/IRN/% of time

» Scenario 6: SWD, receliving itinerant
iIntervention specialist services at home from

How Received How Received District Percentage of Sent To
Who Reports? .
Element IRN Relationship Time Reason/IRN/% of time
District of Res | ES/ESC IRN/0%

ESC H DOR 1 50 NA/* ¥ %A% /0%
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PS Scenarios, cont.

»Scenario 7. SWD, receiving speech as
Instruction at home from ESC
****** ES/ESC IRN/0%

ESC H DOR 1 50 NA/*HHxE% /0%

P Scenario 8: SWD, receiving speech services at
home from ESC
****** ES/ESC IRN/0%

ESC I DOR 2 0 NA/* kA% /0%
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STAFF/COURSE (L)
COLLECTIONS



Initial Staff/Course (L)
Collection — TLC Status Report

» Review regularly before close of collection
» January 31, 2018

» Report can change even if you have not
changed your data

> Updated daily
> Data changes at other entity

»Use Report Explanation when working with
the report
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TLC Status Report Explanation

ODE Home > Topics > Data > EMIS > EMIS Documentation
> EMIS Validation and Report Explanations

Report Name Date Posted
CTE Error Detail Report 8/13/15
Current Enroliment Headcount Summary and Detail 12/22/14
Expenditure Detail Report (EXPD-001) 6/26/17
Federal Child Count Detail and Federal Child Count Statement of 11/16/17
Assurances
FTE Detail Report 10/20/17
General Issues 8/30/17
General Missing Data (H) 7/10/14
Student Cross Reference (SCR) Conflicts 2117117
Staff Missing 10/21/13
Student Grad Info 11/18/13
Student Missing 10/21/13
" ‘
< Teacher Licensure Course Status 12/19/17 >
__’
m 37717




TLC Status Report Explanation

TABLE OF CONTENTS

REVISION HISTORY 2

TEACHER BV AL U AT E D e 5

0L L ECTION S AND B ORI e e e 5
LI L T O 6
EPT DEST IRN (Report Destination IRN)
LOC IRN (Location IRIN ). e 6
L A T A N E ettt e e s e e £ e e e 2 e st e £ sn e 2 £ et e m e e e n e 6
SE NV ERITY CIODIE . .ottt e et s e e s e s e s en e £ e n e 2 s 2 e s s mmem e mm e m e s mmn e 6
b I L R I 7
SUBICT DESCR (Subject DesertptiOm . e 7
O L N o D - Tl T v (= D 7
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Teacher Evaluated

Where there is only one teacher reported for a course, that is the
teacher who will appear on the TLC Status Report. Where there is
more than one teacher reported for a course, a determination must be
made of which teacher to consider.

The amount of time the teacher was with the course is considered
first. If one teacher has a greater percentage of time with the course
than any other, then that is the teacher who will appear. If there are
multiple teachers that match the greatest percentage of time with the
course, the report will list the first one found with a proper cert flag
of Y. If in this case no teacher is found with a proper cert flag of Y,
then the first teacher found for the course will appear on the report.
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Collections and Records

The data for the TLC Status Report is taken from the Initial Staff/Course (L), Beginning
of Year Student (S), SOES Beginning of Year Student (S), Midyear Student (S), and
SOES End of Year Student (S) Collections. Data from the following records appear on
or are used for the TLC Status Report.

« Contractor Staff Employment (CJ) Record

« Course Master (CN) Record

* Grade Schedule (DL) Record

« Staff Course (CU) Record

« Staff Demographic (Cl) Record

« Staff Employment (CK) Record

« Student Attributes—Effective Date (FD) Record
» Student Course (GN) Record

The credential information used for this report is taken from the CORE database. This
Information is available to you through the CORE Educator Profile. Organization type is
taken from the Ohio Educational Directory System (OEDS). From these records and
sources, the following data is used in processing and creating the TLC Status Report.
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Submitted Data

Table 1. Submitted Data Used in Creating the TLC Status Report

Element Name Record Field # Record/Source

Building Name QEDS

Course End Date CIN290 Course Master Record
Course Enrollment End Date GIN170 Student Course Record
Course Enrollment Start Date GIN160 Student Course Record
Course Start Date CNZ280 Course Master Record
Curriculum Code CIN310 Course Master Record
Delivery Method CN320 Course Master Record
Disability Condition FD130 Student Attributes-Effactive Date Record
Education Level CI100 Staff Demographic Record
Educational Option CIN330 Course Master Record
Employee ID CI050 Staff Demographic Record
First Day of School DL0O80 Grade Schedule Record
First Name CI290 Staff Demoeraphic Record
Highly Qualified Teacher CU100 Staff Course Record

Last Day of School DL090 Grade Schedule Record
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Layout and Fields

The TLC Status Report is a Level 2 Report in the Data Collector. The
report name is (TLCS-001) Teacher Licensure Course Status. As with
other Level 2 reports, it Is possible to view the entire report or
portions of the report by Severity Code. The reports are sorted by
Severity Code, Location IRN, Last Name, First Name, Subject Code,
and then Local Classroom Code. The Severity Code order is Fatal,
Critical, Warning, and then Informational.

Collection Request / Report Name Fatal Critical Warn Info Total Category

w Initial Staff and Course Collection (FY18) (2018L1STR)

" (TLCS-001) Teacher Licensure Course Status Liberty Center_000222 0 1 6 141 148 Staff

Generate a single.zip file for all reports | Export report information to a .csv file
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Report Example

Given the number of fields, a complete picture is not provided here. Only
the first few columns are represented; however, all fields are listed in the

report explanation, with explanations or definitions provided as warranted.

Rpt Local

Dest |Loc |Location |Severity |Subjct [Subjct |Tchr State |Last |First |Middle |Classrm
IRN |IRN |Name Code Code |Descr (ID Name| Name |Name (Code
123456(123456 | Hogwarts | I 199999 | Potions |HW1234567| Snape | Severus |Riddle [0987ZYX6W

RPT DEST IRN (Report Destination IRN). This is the IRN to which
the report has been sent.

LOC IRN (Location IRN). This is the building in which the course is
located.

LOCATION NAME. This is the name of the building in which the
course is located.
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Result Codes

Result Severity
Code |[Result Code Description Code

TLO0O0O01 [Course is Properly Certified and course is HQT (HQT Flag set to Y) I

TLO0002 [Course is Properly Certified and HQT reported/calculated as Not a Core Course or I
Not Evaluated (1) (HQT Flag set to blank)

TLO0O003 [Course is Properly Certified and HQT reported as Not HQT (N) (HQT Flag set to N) W

TLO004 [Course is Properly Certified but incorrectly reported as Not a Core Course or Not C
Evaluated (I) (HQT Flag set to N)

TLOO0O05 [Course is Not Properly Certified as no students scheduled into the course (HQT Flag C
setto N)

TLOO006 [Course is Not Properly Certified as no current valid credential or incorrect student F
population (HQT Flag set to N)

TLOO0O07 [Course is Not Properly Certified as substitute credential is not valid as the teacher of F
record in a traditional district (HQT Flag set to N)

TLOO0O08 |Course is Not Properly Certified as Org IRNs are not matching (HQT Flag set to N)

TLO009 |Course is Not Properly Certified as students enrolled are outside the grade range for
the relevant credential (HQT Flag set to N)

TLO0010 [Course is Not Properly Certified as no Staff Course Record reported (HQT Flag set F

to N)
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Error Detection and Correction

Check the subject code (course) being taught. Is the subject code reported the
one most closely aligned with the content of the course?

Are the Student Population, Delivery Method, Educational Option, and
Curriculum Code all reported correctly?

Are students enrolled in the course? If the report shows no students in the
course, then the Proper Cert Flag is set to N.

Is the correct Grade Level entered for students enrolled in the course? The TLC
Status Report looks to the most recent FD Record for both the Disability
Condition and the State Equivalent Grade Level for each student.

Does the teacher have the correct teaching field on their credential to teach the
course? The Certification and Licensure Search and the Certification and
Licensure Dictionary are both resources that can be used to determine which
teaching fields can properly teach each subject code. (Use the search box on
any ODE webpage to find either the Search or the Dictionary.)
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Final Staff/Course (L) Collection

Elements

p Staff Demographic (Cl) Record
>» Absence Days (C1150)

>» Absence Days — Long Term lliness (CI1155)
> Attendance Days (C1140)

p Staff Employment (CK) Record

» High Quality Professional Development
(CK280)

» Student Course (GN) Record
» High School Credit Earned (GN150)
» Partial/Override Credit (GN152)

27



New Principal Report

» Awaiting additional information from
business office

»Will be available toward the end of Initial
Staff/Course (L) Collection or just after

»Will be separate report per building

» Purpose is for Principals to verify
staff/course data that impacts the TLC
Status Report

28



ASSESSMENT (A)
COLLECTIONS



Assessment (A) Collections —

Reminders

» ODE Home > Topics > Data > EMIS > EMIS
Reporting Responsibilities > EMIS Data Collection
Calendars

» Changes announced via Newsflash

P Assessment record required for student when

» Enrolled during administration window
» District Relationship (FS140) =1

» Upload results to student software when
available
» Collections open before results returned
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Missing Lists — Avallability

P Kindergarten Readiness Assessment (A)
Collection
» Closing February 2, 2018
> Only opportunity to report

»Fall DORP (A) Collection
» Closing February 2, 2018

» Early Learning Assessment (A) Collection

» One full year collection for both administrations
» Fall and Spring
» Open through June 29, 2018

» Missing report for each administration
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Why Students Are On Missing

Lists

» Enrolled in Test Window
» Check student enrollment reporting

» Has vendor test results
» Compare FA records with vendor file

» Enrolled in Test Window and has vendor test
results
» Check both of the above

» Fatal
» Check Level 1 Validation errors
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IMARCH FOLLOW-UP
(D) COLLECTION



March Follow-up (D) Collection

» Opens February 2, 2018

» Districts can begin preparing now

» ldentify prior year CTE concentrators who
have left secondary education

> Send out surveys

» FY18 documents now available

» ODE Home > Topics > Career Tech > Data
and Accountability > Perkins Resources >
Perkins IV Secondary CTE Follow-Up

34



FY18 Concentrator Appeals

»Will open sometime after receipt of March D
list of students

P Identify CTE Program of Concentration data
reporting issues excluding students from
2018 March list

» Potential issues
» Not reporting concentrator data

» Reporting concentrator data that does not
align to student courses
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Important Appeals Information

ODE Home > Topics > Data > EMIS > EMIS Reporting
Responsibilities > EMIS Data Appeals

VAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVEA A AAVAVAVAVAVAVA A A AVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVA VA

Special Notes:

Appeals must include student-level data using the 2018
Concentrators Appeal Student Data template. If incomplete
or inaccurate data is provided, the appeal may not be
accepted.

Resources:

For CTE data and calculation related questions, please see the
FY2017 Program Matrix, CTE Report Card Technical
Documentation or contact the Office of Career-Technical
Education.

PAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVA AV AVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVATAVAVAVAVAVAAVA VA
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Appeals File, Read First Tab

/
2018 CTE March Concentrators Appeal File

Allow districts the opportunity to identify 'CTE Progran#/ of Concentration' data reporting errors in the past that are
March list. Errors could include not reporting any cgficentrator data or reporting concentrator data that does not ¢

'nstructions:

B Y Y A A N Y A A AV AN Y A A AV AV AV A AV A AV A A VAV AV AN AV AV AVAVAVA VA A

VAVAVAVA AV AVAV AV AV AVAVAV AV AVAVAVAVAVAVAVAVAYAVAVAVAVAT AV S AV AV A VAV AV AV AV AV AV AN AV AV AV AV AV AV AV AV AV AV AV AV AV AV A VAN AV A AV AV AV AN AV AV AV AV A VA A VAV AV AV AV AVAVAVAVAVA VAV AV

Subiect Code Thefubject code of the CTE class that the student was enrolled in (receiving CTE weighted fundir
’ Oncentrator. The subject code MUST align to the New Program of Concentration for the studen
Local Classroom Code /| The local classroom code for the subject code provided.

Did this student graduate or dropoutd}é{g (YES/NOQ) Verify that the student either graduated or dropped out during the 2016-2017 school !
the 2016-2017 school year?” have "left school" during this year in order to be included in the 2018 March list.

Resource Link Description
CTE Report Card *ec?micalﬁ; umentation Describes how Concentrators are calculated and CTE March data is used in the calculations on the
FY2017 Program I‘v":e.tsE.L/ Crosswalk showing which subject codes align to each CTE Program of Concentration code.

Read First ESOLERIGN )
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Appeals File, Student Tab

P Student data template to submit data within

an appeal
District | District School Year Student was (or should Current Program
IRN Name SSID have been) reported as a Concentrator | of Concentration
123456 | Anytown City | AB1234567 | 2016-2017 Al :
123456 | Anytown City | CD9876543 | 2014-2015 *x
123456 | Anytown City | EF4567891 | 2015-2016 NO

¢ New Program of
< Concentration

Subject Code

Local Classroom
Code

Did this student graduate or dropout
during the 2016-2017 school year?”

; A0 010610 HS-GRE-1610-01 YES
§ M1 174130 HS-COS-1450-01 YES
¢ N1 145090 HS-IT-1220-02 YES

»Melissa.Maynard@education.ohio.gov
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ODDEX UPDATES
AND REMINDERS



SOES Derived Enrollment

» Student’s enroliment date range
> Impacts Student Contact Address (FG) Record
reporting
» Begin date derived from later of
> First Day of School (DL080)
> Effective Start Date (FS060)
> Effective Start Date (FD060)

» End date derived from earlier of
> Last Day of School (DL090)
> Effective End Date (FS090)
> Effective End Date (FDO70)
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Student Contact Address (FG)

Record

Effective Start Date (FG150) must fall within
SOES Derived Enrollment date range for the
student in order for address to attach

P
p

f not, address will not attach
f reported with default value (blank/no date),

orepare date becomes effective start date
» Address will not attach if prepare date not within
SOES Derived Enroliment range
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SOES Derived Enrollment
Examples

Derived Enrollment date range of student is
8/21/17 — current

» Student Contact Address (FG) Record
reported with Effective Start Date (FG150) of
8/18/17

» Address will not populate

» Student Contact Address (FG) Record

reported with Effective Start Date (FG150) of

8/21/17 or later
» Address will populate
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ODDEX — Enhancements

»SOES

> “Not Reviewable By District” modified to include

reason
» 75 days since last community school update
» No address
» Auto approved/aged out

»SCR
>» Admission Reason added to data exports

»CCP

> Abllity to approve previously rejected agreement
> Abllity to reject previously approved agreement
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ODDEX — Problems Corrected

»SOES

> “Escalated” flags remained active even after
district had closed or cancelled flag

P History — Assessment

> Duplication of records under different

collections
» No new duplications will occur going forward
» Existing duplications will be cleaned up at a
later date
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Questions?




education.c




facebook

Linked [}

€9 Storify

You [T

Socilal Media

Ohio Families and Education
Ohio Teachers’ Homeroom

ohio-department-of-education

storify.com/ohioEdDept

@OHEducation

OhioEdDept
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